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Table 0-1 - Revisions 

Rev Number Date Notes 
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20 June 2023 Updated icon and content 
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Glossary of Terms 

40 October 2024 

Complete rewrite. Converted to Windows OS specific manual, 

All images replaced with new UI layout; Added Sections 3 and 

4 

400 October 31, 2024 

Add content to support MagneSafe V5 Products, Added 5 User 

Instructions (MagneSafe); Updated 3.2.2 Utilities to include 

Offline Mode and remove Test Mode, Added Log Output to 

Utilities, Added updated about screen image to Help; Added 

Appendix B Related Documentation; Updated Revision to 

new three digit scheme. 

410 January 2, 2025 Update Copyright Dates 

411 April 18, 2025 

Update all figures in User Instructions (MagneSafe), 

Removed instructions for entering commands in User 
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1 Overview 
The MagTek Reader Management System (RMS) is a comprehensive application with specialized source 

code designed to streamline the configuration and update process for MagTek readers in enterprise 

environments. Its primary functions include firmware management, key injection, device configuration, 

and the loading and management of terminal, application settings, and Certificate Authority Public Keys 

(CAPKs) required for EMV contactless transactions. 

1.1 Purpose 
The Reader Management System (RMS) application is designed to be compatible with all DynaFlex, 

DynaProx, and MagneSafe products available from MagTek.  

• The main purpose of this app is to streamline the ability to load firmware, device configs, keys, 

Tags and CAPKs into a target reader or more importantly, a large quantity of geographically 

separated readers. 

• The target files are 100% MagTek managed (files managed at MagTek’s host) so the user is not 

able to load the wrong files by accident. 

• The app can auto execute or manually execute the update process which can include all of the 

above file options in a single action.  This prevents the need to load individual files which is 

cumbersome and not practical for scale. 

• The source code can be used to integrate this functionality into 3rd party apps which makes it 

easier for developers to use Magensa Remote Services. 

1.2 Benefits 

The MagTek Reader Management System (RMS) provides several key benefits for merchants 

and businesses, these include: 

1. Centralized Management: RMS allows for the remote management and configuration 

of MagTek readers across multiple locations from a single platform. Merchants can 

update firmware, keys, terminal settings, and CAPKs without manual intervention, 

reducing time, cost, and effort. 

2. Enhanced Security: RMS supports compliance with industry standards, such as PCI 

DSS, by ensuring secure payment card transactions and protecting sensitive customer 

data. It enables a secure process for keeping readers up to date with the latest firmware 

and configurations. 

3. Efficient Updates: RMS automates firmware updates and maintenance, allowing 

merchants to push updates remotely. This ensures all devices run the latest firmware, 

enhancing system reliability and reducing the need for manual updates. 

4. System Reporting: RMS offers reporting capabilities to track firmware versions and 

device settings, providing detailed insights by serial number for firmware, terminal, and 

CAPK updates in both production and test environments. 

5. Scalability and Flexibility: RMS is scalable to meet the needs of businesses, whether for 

a single store or multiple locations. It supports both iOS, Android and Windows, allowing 

flexibility in device management. (See each OS specific for further details) 

6. Cost Savings: Automating reader management with RMS reduces the need for on-site 

visits, lowering maintenance costs and minimizing downtime. Centralized control 

streamlines administrative tasks, boosting operational efficiency. 

7. Improved Customer Experience: Efficiently managed payment readers reduce 

transaction errors and delays, improving customer satisfaction and loyalty, which 

positively impacts business reputation and revenue.
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Windows System Requirements 
The RMS app is designed to work with Windows 10 or newer Operating Systems. 

Note: Not all configuration options are available for all Secure Card Reader Authenticators (SCRAs). The 

available configuration options depend on: 

• The specific SCRA model in use. 

• The configuration options provided by MagTek. 

Important: Some commands may require a device reset. 

• Refer to the Programmer's Manual for each device to see which commands are affected. See 

Appendix B Related Documentation. 

RMS Windows Application 

• Windows Application (PN 1000009734) 

• Compatible with both USB and Bluetooth Low Energy (BLE) connected readers, as well as 

WLAN enabled readers. 

• Supports MagTek MagneSafe and DynaFlex/DynaProx readers. 
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2 Magensa Remote Services 
A Remote Services (RS) account is required for billable services. An RS account is NOT required for 

non-billable services. Billing is triggered by RS activity (this middleware does not affect the billing 

mechanism within RS). Middleware operates between Magensa RS and the client application. 

 

The primary feature of this middleware is enabling developers or users to auto-launch or perform single-

click actions within their application to: 

 

• Load firmware for MagneSafe readers. 

• Load both Main Firmware (FW) and Bluetooth Low Energy (BLE) Firmware. 

• Load firmware by Device ID, allowing compatibility across multiple reader generations with 

different firmware versions. 

• Load terminal and application settings. 

• Load CAPKs (Certification Authority Public Keys). 

• Load encryption keys. 

• Load device configurations. 

 

2.1 Onboarding 
MagTek will provide the necessary Profile configurations and Web API Keys if requested.  
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3 Installation and User Interface 

3.1 Installation 
Begin by downloading the MagTek Reader Management System.  

 
 

Open the MagTek Reader Management System  Windows app. 

3.2 Tabs and Buttons 
The RMS application has three tabs available at the top of the window as illustrated below. These include 

File, Utilities and Help. 

 

 

3.2.1 File 
The File tab has one button, Exit.  

• The Exit button closes the application and operates identically to the Exit  button in the 

graphical user interface (GUI). 

 

https://rms.magensa.net/ReaderSupport/FirmwareUpdateClient/publish.htm
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3.2.2 Utilities 
The Utilities tab has 9 active buttons for use with DynaFlex/DynaProx devices, Offline Mode  is reserved 

for use with MagneSafe Devices.

 

• Web API Key: The customer will select this button if they have their own custom Web API Key. 

This information will be provided by Magensa during onboarding. 

• Clear Screen: This button removes all content from the Output field, performing the same 

function as the Clear  button in the graphical user interface (GUI).  
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• Detect Device: This button scans for devices connected to the PC used for interfacing. It operates 

identically to the Scan  button in the graphical user interface (GUI), prioritizing the first detected 

USB connection. 

 

• GetEMVConfigs: This feature is only available on MagneSafe devices and is not supported on 

DynaFlex or DynaProx devices. It retrieves device information and logs the data. 
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• GetConfigList: This button performs the same function as the Check Config  button in the 

graphical user interface (GUI). It retrieves the device’s current configuration and populates all 

available configurations in the Configurations dropdown tab. 

 

• Check Tag Updates: this button will check if the current EMV Tags and CAPKs are up to date 

and report the results in the output log.  
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• Always Update: When this button is selected, the device will automatically update if its 

configuration version is lower than the version indicated in the Version field in the GUI. 

Selecting this button will suppress the “Yes/No” popup dialog (see image below) when an update 

is available.  

 
 

The RMS application keeps track of configuration versions in the GUI by indicating a value in 

Version field as illustrated below.  The user may enter 0 in this field to force an update. 
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• Offline Mode (MagneSafe Devices Only): This button should be selected when the user does 

not want the RMS application to retrieve firmware or configuration data from external Online 

sources. The user must make prior arrangements with Magensa to obtain the relevant files and 

instructions needed for Offline Mode to work properly. This button does not work with 

DynaFlex/DynaProx devices. 

 

• Auto Start: When this button is selected, the RMS application will automatically start after 

launching the application.  
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• Auto Close: When this button is selected, the application will automatically close when all 

updates are complete.  

 
 

• Log Output: When this button is selected, it will enable RMS to store output details in a log file. 

To see the Log, the user can go to Help  tab and select the Show Log  button. For more details 

about the Help tab, see 3.2.3 Help. 
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3.2.3 Help 
The Help Tab contains the About, FAQs and Show Log File options.  

 

• About: this button displays a window with the name of the application, the version, and application 

PN number.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• FAQs: this button takes the user to the MagTek.com support page.  
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• Show Log File: this button displays txt file log of events only when a device is connected, and the 

Log Output button is checked in the Utilities Tab. This information is tied directly to the device serial 

number.  
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4 User Instructions (DynaFlex/DynaProx) 

4.1 Connect to a PC 
Select the device Type and Interface before connecting the device to your Windows PC.  This application 

has no auto scan feature, the user must click Scan  when ready to scan for devices.  
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4.1.1 Open Device 
After scanning for a device is complete, click Open .  

 

4.1.2 Device Output 
When successfully opened, the device will display data such as the serial number and firmware ID 

number at the bottom of the window in the Output  field. This information will be necessary when 

contacting MagTek Support. 
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4.2 Profile Name 
Find the "Profile Name" field. The default Profile Name is set to "MagTekProd," for production devices. 

It controls access to files used in MagTek’s standard production deployments.  

 
Note: the examples provided in this document will use the “MagTekTest” profile.  

 

 
 

If you want to customize your RMS profile, you will need to contact your sales representative to create a 

unique profile.  

4.2.1 Check Configuration 
The RMS application allows users to check a device’s current configuration and change it. The profile 

will dictate which configurations auto populate in the dropdown Tab. To check the configuration of a 

device, click Check Config.  

 

 
A list of available configurations will appear in the Details field.  
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• When working with a customer created Profile, the user should have knowledge of the 

configuration list.  Their organization is involved in the Profile creation with Magensa.  The end 

operator should be told ahead of time which configuration to select. 

• When working with a public MagTek Profile, the user may have to consult MagTek Support to 

determine the function of specific configurations. 

4.3 Updates 
When a MagTek reader is connected, the user can press the Update  button to update the device's 

Firmware, EMV Tags and/or Certificate Authority Public Keys (CAPKs).  

 

The user can check which updates the device will receive. Once the updates have been checked, press 

Update .  

 

 
 

Note: Do not press UI Buttons  or disconnect the device while firmware updates are in progress.  

The user will be prompted to click Yes  or NO  for each update that will be performed.  
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4.3.1 Updates Successful 
When the update process is complete, the Details field will display: …done  indicating the update is 

successful. 

 
Note: The Details and Output field will display both successful updates and any failures when verifying 

update status. 
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4.4 Commands 
Navigate to the Command field to enter a command.  

• Please see the individual device’s Programmer’s Manual for a full list of Commands.  

4.4.1 Valid Command 
When a valid command is entered, the Output field will return a response command that can be cross-

referenced with a known response command to verify functionality. Command Request and Response 

examples can be found in the individual device’s Programmer’s Manuals.  

 
Be sure to enter a Valid HEX String with no spaces between the bits, the application will not recognize 

Hex strings with spacing between bits.  

 

 

4.5 Exit 
Press the Exit  button to close the application.
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5 User Instructions (MagneSafe) 

5.1 Connect to a PC 
Select the device Type and Interface before connecting the device to your Windows PC.  This application 

has no auto scan feature, the user must click Scan  when ready to scan for devices.  
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5.1.1 Open Device 
After scanning for a device is complete, click Open .  

 

5.1.2 Device Output 
When successfully opened, the device will display data such as the serial number and firmware ID 

number at the bottom of the window in the Output  field. This information will be necessary when 

contacting MagTek Support. 
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5.2 Profile Name 
Find the "Profile Name" field. The default Profile Name is set to "MagTek_Production," for production 

devices. It controls access to files used in MagTek’s standard production deployments.  

 

 
 

If you want to customize your RMS profile, you will need to contact your sales representative to create a 

unique profile.  

5.2.1 Check Configuration 
The RMS application allows users to check a device’s current configuration and change it. The profile 

will dictate which configurations auto populate in the dropdown Tab. To check the configuration of a 

device, click Check Config.  

 

A list of available configurations will appear in the Details field. 
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• When working with a customer created Profile, the user should have knowledge of the 

configuration list.  Their organization is involved in the Profile creation with Magensa.  The end 

operator should be told ahead of time which configuration to select. 

• When working with a public MagTek Profile, the user may have to consult MagTek Support to 

determine the function of specific configurations. 

5.3 Updates 
When a MagTek reader is connected, the user can press the Update  button to update the device's 

Firmware and Configs. 

 

The user can check which updates the device will receive. Once the updates have been checked, press 

Update .  

 

 
 

Note: Do not press UI Buttons  or disconnect the device while firmware updates are in progress.  

 

5.3.1 Update Status 
When the update process is complete, the Details field will display: The installed Main firmware is 

newer than currently available on this update service . If the current configuration is up to date. 

 
Note: The Details and Output field will display both successful updates and any failures when verifying 

update status. 
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5.4 Exit 
Press the Exit  button to close the application. 
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Appendix A Glossary of Terms 
 

• API – Application Programming Interface 

• EMV –Europay, MasterCard® and Visa® 

• FAQs – Frequently Asked Questions 

• KSN - Key Serial Number 

• MUT - MagTek Update Token 

• SDK – Software Developer’s Kit 

• SN - Serial Number 

• UIK - Unique Identifier Key 
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Appendix B Related Documentation 
To view or download any of the documents mentioned in this manual, visit 

https://www.magtek.com/support.  

B.1 Installation and Operation Manuals 

D99820020-DYNAMAG DUO INSTALLATION AND OPERATION MANUAL   

D998200382- DYNAFLEX FAMILY OF PRODUCTS THREE-WAY SECURE CARD READER 

AUTHENTICATORS INSTALLATION AND OPERATION MANUAL 

D998200595- DYNAFLEX II GO SECURE CARD READER AUTHENTICATOR INSTALLATION 

AND OPERATION MANUAL 

D998200110- EDYNAMO INSTALLATION AND OPERATION MANUAL 

D998200321- IDYNAMO 6 INSTALLATION AND OPERATION MANUAL 

D998200614- IDYNAMO 5 GEN III SECURE CARD READER INSTALLATION AND OPERATION 

MANUAL 

D998200257- TDYNAMO INSTALLATION AND OPERATION MANUAL   

D998200203- DYNAMAG DUO INSTALLATION AND OPERATION MANUAL 

D998200104- DYNAPAD INSTALLATION AND OPERATION MANUAL   

D998200265- DYNAWAVE INSTALLATION AND OPERATION MANUAL   

B.2 Programmers Manuals 

D998200383-DYNAFLEX PRODUCTS THREE-WAY SECURE CARD READER 

AUTHENTICATORS PROGRAMMER'S MANUAL (COMMANDS) 

D998200489-DYNAPROX PRODUCTS EMV CONTACTLESS/NFC CARD READERS 

PROGRAMMER’S MANUAL (COMMANDS) 

D998200597-DYNAFLEX II GO SECURE CARD READER PROGRAMMER'S MANUAL 

(COMMANDS) 

D998200115-EDYNAMO PROGRAMMER'S MANUAL (COMMANDS) 

D998200324-IDYNAMO 6 PROGRAMMER'S MANUAL (COMMANDS) 

D998200226-TDYNAMO PROGRAMMER'S MANUAL (COMMANDS) 

D998200587-IDYNAMO 5 GEN III SECURE CARD READER PROGRAMMERS MANUAL 

(COMMANDS) 

D998200176-DYNAMAG / MAGNESAFE V5 INTELLIHEAD USB / MAGNESAFE V5 READERS 

USB PROGRAMMER'S MANUAL (COMMANDS) 

D998200173-DYNAPAD PROGRAMMER'S MANUAL (COMMANDS) 

D998200215- DYNAWAVE PROGRAMMER'S MANUAL (COMMANDS) 

 

 

 

https://www.magtek.com/support
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Appendix C Warranty and Software License 
 

C.1 Limited Warranty 
MagTek warrants that the products sold pursuant to this Agreement will perform in accordance with 

MagTek’s published specifications.  This warranty shall be provided only for a period of one year from 

the date of the shipment of the product from MagTek (the “Warranty Period”).  This warranty shall apply 

only to the “Buyer” (the original purchaser, unless that entity resells the product as authorized by 

MagTek, in which event this warranty shall apply only to the first repurchaser). 

 

During the Warranty Period, should this product fail to conform to MagTek’s specifications, MagTek 

will, at its option, repair or replace this product at no additional charge except as set forth below.  Repair 

parts and replacement products will be furnished on an exchange basis and will be either reconditioned or 

new.  All replaced parts and products become the property of MagTek.  This limited warranty does not 

include service to repair damage to the product resulting from accident, disaster, unreasonable use, 

misuse, abuse, negligence, or modification of the product not authorized by MagTek.  MagTek reserves 

the right to examine the alleged defective goods to determine whether the warranty is applicable. 

 

Without limiting the generality of the foregoing, MagTek specifically disclaims any liability or warranty 

for goods resold in other than MagTek’s original packages, and for goods modified, altered, or treated 

without authorization by MagTek. 

 

Service may be obtained by delivering the product during the warranty period to MagTek (1710 Apollo 

Court, Seal Beach, CA 90740).  If this product is delivered by mail or by an equivalent shipping carrier, 

the customer agrees to insure the product or assume the risk of loss or damage in transit, to prepay 

shipping charges to the warranty service location, and to use the original shipping container or equivalent.  

MagTek will return the product, prepaid, via a three (3) day shipping service.  A Return Material 

Authorization (“RMA”) number must accompany all returns.  Buyers may obtain an RMA number by 

contacting MagTek Support Services at support@magtek.com 

 

EACH BUYER UNDERSTANDS THAT THIS MAGTEK PRODUCT IS 

OFFERED AS-IS.  MAGTEK MAKES NO OTHER WARRANTY, EXPRESS OR 

IMPLIED, AND MAGTEK DISCLAIMS ANY WARRANTY OF ANY OTHER 

KIND, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS 

FOR A PARTICULAR PURPOSE. 

 

IF THIS PRODUCT DOES NOT CONFORM TO MAGTEK’S 

SPECIFICATIONS, THE SOLE REMEDY SHALL BE REPAIR OR 

REPLACEMENT AS PROVIDED ABOVE.  MAGTEK’S LIABILITY, IF ANY, 

SHALL IN NO EVENT EXCEED THE TOTAL AMOUNT PAID TO MAGTEK 

UNDER THIS AGREEMENT.  IN NO EVENT WILL MAGTEK BE LIABLE TO 

THE BUYER FOR ANY DAMAGES, INCLUDING ANY LOST PROFITS, LOST 

SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES 

ARISING OUT OF THE USE OF, OR INABILITY TO USE, SUCH PRODUCT, 

EVEN IF MAGTEK HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 

DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY. 
 



Appendix C - Warranty and Software License 

MagTek Reader Management System (RMS)| Windows Application | Installation and Operation Manual 

 

Page 32 of 34 (D998200581-411) 

Limitation On Liability 

 

EXCEPT AS PROVIDED IN THE SECTIONS RELATING TO MAGTEK’S LIMITED WARRANTY, 

MAGTEK’S LIABILITY UNDER THIS AGREEMENT IS LIMITED TO THE CONTRACT PRICE OF 

THIS PRODUCT. 

 

MAGTEK MAKES NO OTHER WARRANTIES WITH RESPECT TO THE PRODUCT, EXPRESSED 

OR IMPLIED, EXCEPT AS MAY BE STATED IN THIS AGREEMENT, AND MAGTEK 

DISCLAIMS ANY IMPLIED WARRANTY, INCLUDING WITHOUT LIMITATION ANY IMPLIED 

WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 

 

MAGTEK SHALL NOT BE LIABLE FOR CONTINGENT, INCIDENTAL, OR CONSEQUENTIAL 

DAMAGES TO PERSONS OR PROPERTY.  MAGTEK FURTHER LIMITS ITS LIABILITY OF ANY 

KIND WITH RESPECT TO THE PRODUCT, INCLUDING NEGLIGENCE ON ITS PART, TO THE 

CONTRACT PRICE FOR THE GOODS. 

 

MAGTEK’S SOLE LIABILITY AND BUYER’S EXCLUSIVE REMEDIES ARE STATED IN THIS 

SECTION AND IN THE SECTION RELATING TO MAGTEK’S LIMITED WARRANTY. 
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C.2 SOFTWARE LICENSE AGREEMENT 
IMPORTANT:  YOU SHOULD CAREFULLY READ ALL THE TERMS, CONDITIONS AND 

RESTRICTIONS OF THIS LICENSE AGREEMENT BEFORE INSTALLING THE SOFTWARE 

PACKAGE.  YOUR INSTALLATION OF THE SOFTWARE PACKAGE PRESUMES YOUR 

ACCEPTANCE OF THE TERMS, CONDITIONS, AND RESTRICTIONS CONTAINED IN THIS 

AGREEMENT.  IF YOU DO NOT AGREE WITH THESE TERMS, CONDITIONS, AND 

RESTRICTIONS, PROMPTLY RETURN THE SOFTWARE PACKAGE AND ASSOCIATED 

DOCUMENTATION TO THE ADDRESS IN THIS DOCUMENT, ATTENTION: CUSTOMER 

SUPPORT. 

 

TERMS, CONDITIONS, AND RESTRICTIONS 
MagTek, Incorporated (the "Licensor") owns and has the right to distribute the described software and 

documentation, collectively referred to as the "Software." 

 

LICENSE:  Licensor grants you (the "Licensee") the right to use the Software in conjunction with 

MagTek products.  LICENSEE MAY NOT COPY, MODIFY, OR TRANSFER THE SOFTWARE IN 

WHOLE OR IN PART EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.  Licensee 

may not decompile, disassemble, or in any other manner attempt to reverse engineer the Software.  

Licensee shall not tamper with, bypass, or alter any security features of the software or attempt to do so. 

 

TRANSFER:  Licensee may not transfer the Software or license to the Software to another party without 

the prior written authorization of the Licensor.  If Licensee transfers the Software without authorization, 

all rights granted under this Agreement are automatically terminated. 

 

COPYRIGHT:  The Software is copyrighted.  Licensee may not copy the Software except for archival 

purposes or to load for execution purposes.  All other copies of the Software are in violation of this 

Agreement. 

 

TERM:  This Agreement is in effect as long as Licensee continues the use of the Software.  The Licensor 

also reserves the right to terminate this Agreement if Licensee fails to comply with any of the terms, 

conditions, or restrictions contained herein.  Should Licensor terminate this Agreement due to Licensee's 

failure to comply, Licensee agrees to return the Software to Licensor.  Receipt of returned Software by 

the Licensor shall mark the termination. 

 

LIMITED WARRANTY:  Licensor warrants to the Licensee that the disk(s) or other media on which 

the Software is recorded are free from defects in material or workmanship under normal use.  

 

THE SOFTWARE IS PROVIDED AS IS.  LICENSOR MAKES NO OTHER WARRANTY OF ANY 

KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 

WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 

 

Because of the diversity of conditions and hardware under which the Software may be used, Licensor 

does not warrant that the Software will meet Licensee specifications or that the operation of the Software 

will be uninterrupted or free of errors. 

 

IN NO EVENT WILL LICENSOR BE LIABLE FOR ANY DAMAGES, INCLUDING ANY LOST 

PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES 

ARISING OUT OF THE USE, OR INABILITY TO USE THE SOFTWARE.  Licensee's sole remedy in 

the event of a defect in material or workmanship is expressly limited to replacement of the Software 

disk(s) if applicable. 
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GOVERNING LAW:  If any provision of this Agreement is found to be unlawful, void, or 

unenforceable, that provision shall be removed from consideration under this Agreement and will not 

affect the enforceability of any of the remaining provisions.  This Agreement shall be governed by the 

laws of the State of California and shall inure to the benefit of MagTek, Incorporated, its successors or 

assigns. 

 

ACKNOWLEDGMENT:  LICENSEE ACKNOWLEDGES THAT LICENSEE HAS READ THIS 

AGREEMENT, UNDERSTANDS ALL OF ITS TERMS, CONDITIONS, AND RESTRICTIONS, AND 

AGREES TO BE BOUND BY THEM.  LICENSEE ALSO AGREES THAT THIS AGREEMENT 

SUPERSEDES ANY AND ALL VERBAL AND WRITTEN COMMUNICATIONS BETWEEN 

LICENSOR AND LICENSEE OR THEIR ASSIGNS RELATING TO THE SUBJECT MATTER OF 

THIS AGREEMENT. 

 

QUESTIONS REGARDING THIS AGREEMENT SHOULD BE ADDRESSED IN WRITING TO 

MAGTEK, INCORPORATED, ATTENTION: CUSTOMER SUPPORT, AT THE ADDRESS LISTED 

IN THIS DOCUMENT, OR E-MAILED TO SUPPORT@MAGTEK.COM. 

 

DEMO SOFTWARE / SAMPLE CODE: Unless otherwise stated, all demo software and sample code 

are to be used by Licensee for demonstration purposes only and MAY NOT BE incorporated into any 

production or live environment.  The PIN Pad sample implementation is for software PIN Pad test 

purposes only and is not PCI compliant.  To meet PCI compliance in production or live environments, a 

third-party PCI compliant component (hardware or software-based) must be used. 
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